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Computer:_ (331) (E) 

(Set No. 18) 
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1) In J,va; which method of fiJe class returns true 
If file exists, otherwise returns false t 

(A).file {B) · Volatile data 
'l(C}-Hard disk (D)_ App�cation 

2) 

3) 

4) 

5) 

(A) boolean File Dir( ) Pq � 2 2 2. 
�olean isFile( 1· ... ,. 

(C) boolean listFile( ) 

10) Which of the following ls a very popular La.Tex 
distribution available in the standard ubuntu 

§ repositories t -
(D) boole� getFname( ) · · (A) f Tex <- Lt I (B) d Tex 
Java supports which type of s�s t Pg-2 S (9Jex Live · .. · (D)geteX live 
(A) Byte stream (B) Character stream 11) Which of the following file extension ls used by 

�oth (A) and (B) _(D) Binary Stream La.Tex t P q - '2 � C\ • _ . · 
In Java, which of the following is a subclass of CA) .ext L..LBY1ex (C) .lat (D) .ltx 
Reader cbJ.ss t Pq '.l '2.6 · 12) Wecancompile theLaTexdocument byissuing 
(A) lnputstreamReader which command at command prompt t · Pg _ i y f 
{B)_ BufferedReader CA) pdftax filename · CB) pdflat filename 
(C) Outputstream (C) pdfext filename L(BJpdflatex filename_: •. 

1.-(BfBoth (A) and (B) 13) La.Tex commmid starts with which character, 
In Java, which method of mewrlter class ls followed by the command name t �g .- · 2 41 
used to close the stream t Pg· :2:2. S _(A) - JBY'\ (C) $ (D) * 

�void close() . (B) int break() · 14) lnla,Texdocument,lfwewant tolnsert abreak 
(C) void terminate( ) (D)_ quit( ) -in lines which command we win use at the e�d. 
In Java, scanner class can be used to perfonn of each line except last line� paragraph t P� � 2\.\ 2 
which of the foll��g operations t CA) • (B) ; �\ CD) : · 

(A) Read from the file 
(B) �e a string separated �y· delimeters 

2..� � (C) Accept input from keyboard 

15) Which of the following character is known as 
reserved character in La.Tex t P 1}- - 21.f 3 
(A)# . (B) $ 

<-33 ,JJ1J All of above 
6) 

7) 

8) 

9) 

2..2.o. 

In Java, which of the following is used as a 
separator between fields of a record t �-

�pace {B) Variable 2 � 9 

(C) Delimiter {D) Path 
.In Java, which method of console class reads a 
single line of text from the console-? Pq - 2 3 
(A) Smng PrintLlne( ) (B) Char ge�e( ) 
(C) Char Print( ) I.Jl;)tString readLlne( ) 
In Java, readO method returns what to identify 
the end of data in the stream tr� - .2 2 � 
(A) End UBr"-1 (C) 1 (D) 0 
Which of the following refers to a collection of 
data stored on a non-volatile device in a 
computer system t 

(C) % �of these 
16) Which of the following website hosts the LaTeX 

packages T P Q - '2 S'6 · · 
(A) CTEN\..{Bf"CTAN ·cc) CWAN (D) CI.EN: ,: 

17) By default elements are assigned number upto 
which level that ls upto subsections in La.Text Pg - 2 4 -=f 
(A) Level 6 {B) Level 4 

�vel 2 (D) Level 3 
18) If compilation was successful, you may �lect 

· which menu option to view file in default 
document viewer in La.Tex t �9 _ · 2 � 9 
(A) Tools ➔ Run · _ - · 

{B) File ➔ Run 
(C) Edit ·4 Compile ➔ Go 

�ools ➔Go 
460 
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_19) In LaTex packages like �math, am.s�b 
and. amsfonts ls created by which of the 
following society t �� -- ".l S \ -. _ · 

(A� Russian Mathemati� Society 
CB) Indian Mathematical Society 

(C) European Mathematical Society 
·, l...{BJ"&nerican Mathematical Society 

20) Which of the following Mathematical �ol ls 
used In LaTex -t Z.:S-2_ . 

�< (B)# 

J9 = · 
_ (D) All of these 

· · 21) Which of the following operator ls used to 
_denote a subscript or an Index ln-LaTex t 
(A)� (less.than eq�al to) ��-is� 

(B) ,.... (caret) 
(C) .,.. (minus) �-(underscore) 

28) If Java program ls compiled without �r 
we can execute it In · Sci.TE editor tiy which 
menu t.·-_ • �� - \?, \ · _. 
(A) Compile ➔ Run.➔ Go 

(B) Edit ➔ Go 
�ools ➔ Go (D) File ➔ Go 

29) Java iupports how many primitive data types t 
(A) 12 � - (C) 11 _ (D) 10 15G 

30) What ls the storage space for datatype float In · 
Javar·Pca

-134·. - ·_ 
� �ytes '-(B) 2 bytes 

CC) 1 byte CD) 8 bytes 
31) Real numbers . In °iava are compliant with 

wbl� of the followln� t pg· - l '3 4-
CA) IEE 36 CB)JEE16 

(C)�780 .\.-9311EEE754 

. 22) · Which of the following part of LaTex 32) · In_J_ava, variable name sh�uld begin with 

document contains the metadata f �- 2 5 � wblch_ of the
_ 
!0Ilo�g t P � - \ � S -

(A) Preface \.$f Premµble ·. (A) Alphabet CB) Underscore ( _) 

(C) TOC (D) Environment (C) Dollar sign ($) \..111)A11 of these 
33) in Java, a name used for · constant value ls 23l :1n LaTex, which of the following begins with o '::l ,-

, .. : . ·.\begin {name} and ends with \end {name} t known as what t \' <a - \ 0 
o (A) String return \..-OOliteral (A) Group vfflf EnvironmenHn-2S _ 

(C) Pream,ble (D) Section 
� (G) Unicode Quote (D) EBCD�C 

24) Which document· class ls used for creating 
presentation slides and it automatically sets 
_larger

_ 
font· size

f
n LaTex t 

__ 2..1•-t� 
(A) Impress . (B) Beamer 

·,,. · · ·· tlS)..81ides · (D) Article 

34) Java 7 · aJs� supports binary numbers, using 
digits O �d 1 but it should be prefix by which 
of the following t P9 - I 3 -:\-

'--tfi'f"Ob OI OB - (B) B 

(C) Bl (D)BO 

25) In Java, at which level platform Independence 
��-:- \ 2 � _ ls possible due to bytecode in�rpreter t 

(A) Browser (B) Source 

35) In Java, for type boolean there are _precisely 
two literals, which are they t �� - \ 3 'iS' 
CA) Y and N · (B) 1 and O 

(C) M�chine L..(I)tBinary 
26) In Java, the machine language for Java virtual 

\ '1--<t> ·, machine is. known as which code 1 
()(\. ..,, \\) (A) J�va filecode � Java bytecode 

(C) Java intcode (D) Java sourcecode 
To compile the Java program we have to type 
what In frant of source file name t 

�Javac filename.java (B) javad filename 
(C) java filename.html (D) javas filename.Java 

�1iue and False (D) Yes and No 
36) 1n Java, characters are stored by how many bit . 

Unicod� characters t � - \ 3 � 
(A) 36 - bit .CB) 4 - .bit 
(C) 8 - bit L,.(Qr1'6- bit 

37) String literals i� Java is a sequence_ of 
characters which can be enclosed in which of 
the follo�g t �g - 13 9 
(A)_ Dollar($·_.$) YE}Double quotes(" ") 

(C) Back quotes (' ·') (D) Single quotes (' ') 
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38) In Java, ·docume�tatlon ·co�ents b� Blid. 48) 
ends with which _of the �ollo� t �g - \ 3 q 

�• and*/ ·. · · (BJ"·/� 8I)d */ · 

All lnstan� of _class ·are· allocated inemory In 
data structure· :1n'. Java ·and It Is known as 
�ch of �e following

. 
t -� � \6 3 . · 

(AJ·-·Directory (B)·Fhe (C) /.* and / (DJ I/ 
39) Arithmetic operators In Java, can· be applied 

on which numeric data ' . ? ca - � y q; 
(A) short · (BJ float 

'. 40) 
(C) �e � of these 
In Java, which of th� �o��g · 1s ��wn as 
unary operators for lncren,.�nt .�d decrement 
operator t _ _ P <a - l 4 2 _ 

. 
. 

. 
. · 

(A) >= and < = • (B) + and -
CC)== and!� � and--

. . . 
41) Which _of the (ollowlng is considered •� 

comparison operator � Java t p� - l 4 a 
(A) = . · {B) / · (C) % � = 

42) In Java, logical operators are also �ed which 
of tire following operators If �ey ()perate on 
Bool� operands t .- �i· -:- \\.\a _· ._ 
(A) _Assignment Operator 

\03rBoolean Operator .. . .. 
(CJ Incremept Operator ·. · .. · 
_(D) �elationalOpera�r · � ·· · ".. . - . . . . .. 

43) In Java, conditional operator uses· which two 

�ap CD) Buffer . 
Instance· variables �d instance inetho4s. In 
java. are accessed� o_bj� �d they can be 
_refett� by 1,tSlng ��-operat�r t r Co·_;\ G 3 
(Al Ari�etic operatot" (+) 

. uBti)ot operator· (.) . 
' . .  

�C) �ignment operator (=) 
CD) Colon operator (:) 

SO) V��es of class variables
. 
are �tored where In · . . Ja� l" P cf- l <o � 

: � c1ass·_ .· (B) file . 
(C) hist;ance (D) dir 

51) · Iri.. J�va, �hies defined inside methods or· 
1,1o� �� _caite4 which var1a1>,es

_
, ? _g· - 16 't 

Ci\.) Glopal variable "CB) Instance variable 
(C) Class ·variable �cal variable 

5.2) In Jaya, different forms of �thods_wlth·same 
name ls known. as which of the following,._:: 
�) Copipo�ition . LtBr.f>olymorp� \-'g -\G '=\-
(C� Muta�ors ·. · (D)Inheritance 

symbols In expression tq delimit three 5a) 
ope�ds t �<'d -· \ 4.\.\ . 

Which access·rilodifiers can be.used before the 
�e �f.�bl�-or_ m�od fu. J�� i�-i- \ 9-0 

(A) 'l ap.d * . (B) • and ? 
L.{€tf and : (D) ·; and ; 

�) .�blic . . . . . . . . (B) Protected _ :. 

44} In Java,. a biock state1,n�nt ·ls ·• -g�oup of 54) 
statements enclosecJ" between ·which ·pair of_ 
bracest �<a-\'-f,- · . . ·_ · ·· 

CC). P#va�e · - · � of these .· · - . 
By µ.sing which access iµo<Qfle�, · �ows access 
only to -s�l� Qr to share. with :the methods 

CA) [/ /J � J (C) C ) (DJ [
° 

I 
. 

. 
45) In Java, which of the following consist of 

attrlbut�s anc:J methods t. � � -\ 5 '6 · . · . (A) Instance (B) V�les 
(C) Object \Wt'Class 

46) Which keyword ls· used to create the object 
which allocates niemory hi Java ·t r � - I <o I 

47). 
IJA)--11ew (B) add .- (C) ins (D) create 
In Java, what Is called to 4utlallze· the newly 
created obj�t t �i - \ (o ( · · . · .-
(A) aasses · . CB) R,eference variable 
(C) Syntax variable L!P}CQnstructor 

�ecJared: � "frien�n

_lll; !�a.t Pg -J_-1.2 , .. 
(A) Pac;kag� . �otected . 
(C) Private (D) rtlblic . 

55) hi Java, ff we want prptected data to be 
modified by others then which·· methods � 19 

:;:::;--�i·--,i� �tter · -.-_ · .-. 
. ��r · . .: · (D) Bo� ·(A) an4 (B) 

56) In 'Java� If �e �t to allow �thet �ethods to · 
react" only _-·_da:ta: valu�.' of _qiti ptogr;un_ w� 
�ould. �e �eh _m�o� 

! · :pi ·._. [ ::J-_"4 _ . 
(A) setter · • ·· - •, �etter·-'. ·. · · . . 
(C) inutator-.::·:.:· 

.- .. _ (D)
°

�oth (A} � (C) 
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57) . � Java, which of the follo�g allows us to 
build new class". with added capa�Uities by 
ext�n� �stirig class r \) ca - \ ',-(o . . 
(A) :·Aggregation . · (B) Polymorphism . . . . . · . . 
(C) Composition .· uJ)31hherltance . . . . 

58) �erlJ.ance mo�el conslst of which type of 
:�� 

� \ "f(o �•�ti����- �etw�-� �o �as�.:� .Ja� t 
(A) 1 : M. '-lBJis- a . (C) 1 :_1 {D) has - a 

59) In ·Java, � · sub class ln�e:rli:s 
. ·all Instance 

� _ \ '1"' � �!abl� �<I methods �m: which ci�s t 
� (l\) Derived class (B} Instance class 

�1:1p.er.
class·: · ct>> ChUd cl� ·. · 

.o 60) Co�ositloli �d aggregatl�� esta�� which 
r� - \ � m,e -�� rel��q�p -�tween �� In Java t 

.I · �has-- a (Bl ·1s: a · CC) � -: a CD) as - a · 
• .. 6,1) ln J�v•, 'vlslblllty �odlfiets' 'prQtected' . .. .  . . • .  . .. 

µiembers a;re 11:v�� .as_,_whlclµn�m, In 
��-\"\1 . thelnherl�e4��1icl�s t ��-� \T·2 : 

�bject 
. 

. . · : 
. 

CB) Public . . 
. CCHnstance . . (D) Private .. . . . . . . 

62) In .-.�,-while using �erltance � "Child class" 

G 
can J,e referred to as which of the following t 

�� - \ ?t' �u�-cl� .. : · (B) Derived � 
(C) Extended cla$s .@An of these 

63) ffl.uch of the f()Ilowlµg. ls · the keyword used to 

� 
re�er · a' ·su:per. ci�s c��t1"9ctor � sub class 

'xi -\ · c.o�tructor ? · 
.. · . . CA) Name. �f subcl� . CB) New 

,;- -�riper :•. (D) Extends 
64) In Java, which varlabJes are d�fined with In a 

f �- \ 6 J° ciass, outside any methqd with static keyword t 
(A) Global variable �ass variable 

. 
. 

(C)..J�ce variable · (D) µ,cal yariaple 
. 65) In Java, arrays are lISeful to rep�ent which 

� � ... \ 'c <o �e of data ? . 
(A.) Ve�pr · · CB) � . 
CG) Multi - dimensional fafAU of. these 

66) ·-hl.J��--•t b use�J� ��nt. �-.D data 
structure �e- table .of-rQW�:Jnd ,collll1U).s t 
W Scalar· . · . (B) Vector· _. . ., . . 

(C) .EJemenL•:· ·. ·. u9rMatrlx·,:•:, 

�' 
•.

. 
·,, 

.. . .n\/ '� 
67) . In. Java, to declare a 1 - D array we µse � p� 

of which braclcets after ·�ay nlline Qf · after 

��l�IS�CJO -�l ;l .· .. • 
68) If. 'sn' ts the objecJ of slfJng class �d Its 

content Is 4'Hello" then whaf is· the value of . 
str. lel}gUl c 1·,··� . �� N0-·"'7 '6: 
(A). error (B) 8 ue,-'5 .· ··(D) 7 . 

69) In Java, which of the fullowing method can 1>e 
. . ... ,, . . �� �ili. ·1ava.u�� 

.
cl�s l P.ca ::� I � 9. 

(A) sort () · · �) fill { ) 
. . . . 

(C) alert C ) 
. 

\.(Dt1lpth CA) aJtd CB) 
• •• • • 1 _ _  • 

·.·.: • • •  

70) In Java, to se�ch ll1l �leµ,�nt ill � aqray, 
Arrays cl� prp��s·wtii� -��tbod t p� .:., 19 0 

��arch() (B) S�JiC) 
CC) Elementsearch( ) CD) Unelndsearch( ) 

71) In J�,· 2 -·n ��y-� �'de�� which 
·oi'the ro����-�rr�� �it· ··P<o ·�--\ 9 I 
CA) hit mam C ·) C ') = ·new int (5), (3J; 

. . . . 
. '\ . . .. 

cs> int i:nalks l 1 c J :.: pew hlt 
.
·CSl {3>; 

CC) fut mar� =·int [5],· 
.
(3]; . 

�t ma_;.ks [ ]: : [ 1 · = new- int [5] [3); 
72) Java: iupports. �Q �- qf .� that m 

handled by. ·which pr'°��
. 
following class or 

c1ass� ' ,_ -r - I ·q 4· ... . . . . ·. · :. . · · 
(A) String �ass� (BJ �trin�tiffer class . : . · .. .. 

\JGtBoth (A) and CB) 
(D) String ·eonstructor class 

73) In Java, ·�o _c:reates �-s�� O�l� with Its 
. · · · fui�· value �ing � Qr�e�! ? .· R · _ · · . 

· · (A) String Cary [object] [ ]) · · <J . 1 9 4 
\---{BfString (chaq 1cy [ jj 

. 
. 

. . 

(C) String (ary [ ]! �t l�n) 
: CD) String Caty ( �) 

74) In Java; c�aracters ar� st�r�4 using how µian.y 
bytes?, · ,-'f� ·. · · , 
CA) 16 bytes ta) 4 .

. bytes 
CC) s·bytes ·. �2·.bf� 

75) WhicJ:i �e -th� method$ prp�4�4 by �trin� 
. class In Java r . . . . . . . 

. 
,{A).To .co�p� .s�gs 

· . ·p� _;_ 19.G · 
(B) _Find Jength of � · · · 
• CC). Combining s�gs· 

�·of·ab�ve· :. 



76) In Java �hlch string dass method returns true 
if lnv�ki�g string Is same as str t 
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84) In Java, by Ii.ow many ways we can create � 
l � array object t 

·(A)· Null _ (B) Three -�'l\vo (D)__On� · (A) int �quals (string boole�) p 9 . _ ( Ci --6 
(B) boolean- Ognore · case str) 

· '-tC)b�Iean equals (string str) 
(D) boolean (string) 

85) In Java, an indication of a probl� that occurs 
during a program's execution, usually- signals 

· �� - -� error Is known as which of the following l 
O �ception (B) Aggregation 

77) In Java, which string class method returns a 
string after _ appending �tr with the invoking (C) Anomaly (D) Deviation 

_ string t 
· 

_ . _ _ 86) . In Java, errors can be. broadly classified into 
· 0 (l 

\ 9 "1 
which category t _ (A)String combine (str) \ o - 1 O (A) Compile - tim�· error_s ra -20 ..3 L-(BT"S�g concat (string str) c, 
(B) Arithmetic errors 

(C) String add (str) 
(D) String join (str) 

(Cl Run - time errors 
�th (A). and (C) 

� 
Java library also provides date class in which 

_, of the following package t P 9 - \ Cf 'is" ·87) � Java, U there is a syntax error in the 
_ program we wm get compllatioJ]. error and will . 
�ot be able-to .crea!e wbi�h file t · Pg -- 20 .3 
(A) .javac (Bj .code (C) .obj �class · 
While. running Java program � _ScITE editor, 
which code indicates that the com1nands 
executed is successful t �� - '2. 0 '-\ 

� (A) java.attr (B) java.lang . 
CC) javaexpi: � Jl)tJava.util 

79) In Java; which method of date class constructs 
- date object using current system time t 

� g - \°' 9 (A)- get Time ( ) (B) get Date ( ) 
\..LCrffate(.). (D) Date Time ( )  . . 

_. 80) In Java, �ch method of date. class fets new 

-88) 

(A) Code "No errors" L{Bf""Code "O" 
(C) Code "Zero error" (P) Code "1" 

. . 

Q, , \ � °' date and tline of mt objec� using ���e� -time l 89) 

\ Co · _ (A) Short getTime ( ) · _ 
Which of the following package in Java, 
contains a hierarchy of classes dealing with 
varl�us �eptions l Q � - '2 0 S _ �oid Se�Time Oong elapsed time) 

(C) Void SetDate· (Date, Time) 
(D) SetDate 0 

81) In Java, which constant of calendar class 
b. 'l QO displays day of calendar month f 
cJ \....(kj1'5ATE (B) D� (date) 

(C) month (D) MONTH (date) 
82) In Java, what are the values used for AM_PM 

constant of calendar class f 

O (A) 1 for AM, 12 for PM 
� "- '2 O 

(B) 1 for AM, 0 for PM 
(C) 1 for AM, 2· for PM 

JP}-9 for AM, I.for PM 
83) In Java, which constant of calendar class 

� -'lQOlisplays Hour in �2 - hour n_otation f 
\ i · (A) H_M_S YB)HOUR 

(C) HOUILMINUTE (D) HOUR.OF _DAY 

(A) Java.Jang . (B) javajo . _ 
(C) java.pac \JBrBoth .(A) and, (B) 

90) . In Java, when an attempt is made to access the· 
array element with an iD:dex ·value that is 
outside the range _ of array which exception 
class is used t P�. - 20 S 
(A) FileNotfoundExcepti.on 
(B) ArrayIOException 

�ylndex.OutOffioundsException 
(D) NullArrayException 

91) In Java, an object - oriented_ technique for 
· managing errors· Is known as which of the 
following f . p� - '2 0 (o 
(A) Error Definition . 

. 
(B) Anomaly Handling 
(C) Termination Handling. 

�ception �anclling 
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. · 9� In Ja�, try statement contains a block of 

� � - 2. 0 ,- s�tement written within which braces t 
· \JM1 l. (B) ·< >. (C)[] 1D)() 

o 93) � Java, a catch block consists of keyword 
\ � - 20 <is' catch followed by how many parameter t 

. � (Single) (B) 4 
(C) 2 (D) 3 
In J�va_program which block Is g�nerally used 
to clean up at the end of executing a try block t 

97) Stor�ge device of computer system can be 
broadly classified Into which of the following 

-98) 

category' �s - ·2. �o .. 
· (A) Volatile storage (B) Non-volatile storage 

.. (C) Dynamic storage �oth (A) and (B) · 
File can exist on  which of the following 
p·�anent storage device t f 9 .;,.. 2 '2. 0 
(A) Hard disk . (B) Compact disc 

(A) Event . �inally ·ccj Catch (D) Throws 99) 
�5) In Java program, which block ls widely used If a 

(C) Optical disk -� of these 
Which of the ·{ollowing extension is use4 for 
binary files t Pg - 2 2:- 0 

file needs to be closed or a critical resource is to 
be released at the completion of program 1 
(A) Event \CBYFinally (C) Qrtch (D) 1i:y 
In Java program, when a 'throw statement_ is 
encouµte:red a search for matchhig which 

(A) .jpeg CB) .MP3 
(C) .class � of these 

100) In Java, which class encapsulates· infomation 
about the properties of a me or a direct�ry 1 

blC?ck � 1 . _/' 
. 

(A) ja�fo.object.Fd' · (B) Java.Jang.Dir 2 2 \ 
(A) Event (B) Finally �tch (D) 1i:y (C) java.util.Dir �va.io.File. 

Answers of Board Question Paper March- 2016 

(1.,... B) (2 -C) 

(11-B) (12-D) 

(21--D) (22.:B) 

(31-D) (32--D) 

(41 :-D) (42-B). 

(51-D) (52-B) 

(6l-D) (62-1;>) 

(71-D) (72-C) 

(8:t.-.A) C82�n1 

(91,�D) (92-A) 

.(3 - D) 

(13-B) 

(23-B) 

(33-B) 
(43-C) 

(53-D) 

(63-C) 

(73:-B) 

(83-Bl 

(93:-A) 

' .. 

(4 -A) (5 - Dl 

(14-C) (15-D) 
"(24-C) ·(25-·D) 

(�4-A) 

(44-B) 

(54-B) 

(64-B) 

(74-D) 

(84-C) 

(94-B) 

•:• 

(35-C) 

(45-D) 

(55-C) 

(65-D) 

(7�_-D) 

(85-A). 
. 

. 

(95-B) 

❖ 

(6 -C) (7 - D) (8 --B) (9 - B) . (10-C) 

(16-B) (17-C) (18 .:.. D) (19 -D) (20-D) 

(26-B) (27-A) (28-C) (29:...B) (30-A) 

(36-D) (37-B) (38-A) (39-D) (40-D) 

(46-A) (47-D) (48-C) (49-B) (50-A) 

(56-B) (57-D) (58-B) (59-:- C) (60�A) 

(66-D) (67-B) (68-C) (69-D) (70-A) 

(76-C) (77-B) (78-D) (79.:..C) (80-B) 

(86-D) (87-D) (88-Bl _(89 -i>) (90-C) 

(96-B) (97-D) (98 -.D) (99 -D) (100-D) 

•:• 

' 
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76) In Java :�vhlch string class method returns true 
if lnv�ki�g string ls same as str t 
(A) int �quals (string boole�) Pg. --( q ·.6 
(B) boolean- (Ignore · case str) 

84) In Java, by liow many ways we can create � 
l � array object t 

·w·Null _ (B) Three -�'Iwo (D)._One. · 

· '--tC)b�Iean equals (string str) 
85) In Java, an indication of a proble� that occurs 

during a program's execution, usually- signals 
· �o-- -an error ls known as which of the following t 

77) 

(D) l>oolean (string} "O 

In J •. .1.., h trln cla thod O �ception (B) Aggregation ava, wllJ.C _ s g S$ me returns a 
string after _ appending ,tr with the invoking (C) Anomaly (D) Deviation 

. strhig t _ . - - _ 86) - In Java, errors can be_ broadly classified into 
· 0 o · · \ 9 "1 which category t (A) String combine (str) \ o - 1 · () 

�tring concat (string str) �) Compile - tim�· erro�s r<a -20 3 

(C) String add (str) 
(D)_ String join (str) 

7(l) Java library also provides date class In which 
T of the f�llowing package t P 9 - \ ·ct � 

·87) 

� (A) java.attr (B) java.lang . 
CC) javaexpi: �va.util 

79) In Java; which method of date class constructs 
- date object using current system time t 

�g - \'� 9 (A)· get Time ( )  ·• (B) get Date ( )  
�ate(.) . (D) Date Time ( ) 

. . 

.- 80) In Java, which method of date class sets new 
. . . . 

. 

88) 

O. .,,. \ °' C\ date and tiine of mi object using e���e� -time t 89) 

\ � · _ (A) Short getTime ( ) - . 
�oid Se�Time 0ong elapsed time) 

(C) Void SeIDate· (Date, Time) 
(D) SeIDate 0 

81) In Java,· which constant of calendu class OO) 

:>a '). 0 Q displays day of calendar month t 
'c> \...CkY15ATE (B) DAY (date) 

(C) month (D) MONTH (date) 
82) In Java, what are the values used for AM_PM 

constant of calendar class t 

O (A) 1 for AM, 12 for PM 

(B) Arithmetic errors 
(Cl Run - time errors 

�th w· anc1 cC> 
.� Java, ·u there ls a syntax error in the 
_ program we will get compilation error and will_ 
�ot be able-to _crea�e whi<:h file t - Pg, - 20 3 
(A) .javac (B) .code (C) .obj �class · 
While running Java program � _ScrrE editor, 
which code indicates that the comtnands 
executed is successful t \"(J - 1 � 4 
(A) Code �o errors" �Code "O" 
(C) Code "Zero error" (D) Code "1" 

Which of the following p�ckage l� Java, 
contains a hierarchy of classes dea!ing with 
various �eptlons t Q � _;, "2 0 S _ 
(A) java.lang · (B) javaJo . _ 
(C) java.pac uBrBoth -CA) and, (B) 

_ In Java, when an attempt is inade to access the -
array element with an i�dex ·value that ls 
outside the range . of array which exception 
class is used t Pq_ - 20 S 
(A)FileNotfoundException 
(B) ArrayIOException 

�ylnd�xOutOmoundsException 
(D) NullAtTayException 

� :- '2 O 
(B) 1 for AM, 0 for PM 

91) In Java, an object - oriented_ technique for 
(C) 1 for AM, 2 for PM 

J!))--8 for AM, 1. for PM 
83) In Java, which constant of calendar class 

D -'loOnsplays Hour in �2 - hour n,otation t 
\ 'e · (A) H_M_S l.{BJHOUR 

(C) HOUR...MINUTE (D) HOUR,_OFJ)AY 

· managing errors· ls known as which of the 
following t . p� - '20 (o 
(A) Error Definition - . 
(B) Anomaly Handling 
(C) Termination Handling -

�ception �andling 


